
eco DC
Energy & DCIM Management
Web GUI
User Manual



eco DC User Manual

ii

PE Device Safety Notice

User Information

Online Registration
Be sure to register your product at our online support center:

Telephone Support
For telephone support, call this number:

International http://eservice.aten.com 

International 886-2-8692-6959
China 86-400-810-0-810
Japan 81-3-5615-5811
Korea 82-2-467-6789
North America 1-888-999-ATEN ext 4988

1-949-428-1111

Set the maximum permissible breaker protection in the building circuitry to the 
current rating specified on the rating plate. Observe all national regulations and 
safety codes as well as deviations for breakers.
Only connect the PE Device to a grounded power outlet or a grounded system! 
Make sure that the total current input of the connected systems does not exceed 
the current rating specified on the rating plate of the PE Device.
There is a risk of explosion if the battery is replaced with an incorrect type. 
Dispose of used batteries according to the relevant instructions.
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User Notice
All information, documentation, and specifications contained in this manual 
are subject to change without prior notification by the manufacturer. The 
manufacturer makes no representations or warranties, either expressed or 
implied, with respect to the contents hereof and specifically disclaims any 
warranties as to merchantability or fitness for any particular purpose. Any of 
the manufacturer's software described in this manual is sold or licensed as is. 
Should the programs prove defective following their purchase, the buyer (and 
not the manufacturer, its distributor, or its dealer), assumes the entire cost of all 
necessary servicing, repair and any incidental or consequential damages 
resulting from any defect in the software.
The manufacturer of this system is not responsible for any radio and/or TV 
interference caused by unauthorized modifications to this device. It is the 
responsibility of the user to correct such interference.
The manufacturer is not responsible for any damage incurred in the operation 
of this system if the correct operational voltage setting was not selected prior 
to operation. PLEASE VERIFY THAT THE VOLTAGE SETTING IS 
CORRECT BEFORE USE.

Product Information

For information about all ATEN products and how they can help you connect 
without limits, visit ATEN on the Web or contact an ATEN Authorized 
Reseller. Visit ATEN on the Web for a list of locations and telephone numbers:

International http://www.aten.com

North America http://www.aten-usa.com
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About this Manual

This user manual is provided to help you get the most out of your eco DC. It 
covers all aspects of the application, including its installation, configuration, 
and operation:

Applications covered in this manual include:

An overview of the information found in the manual is provided below.

Chapter 1, Introduction, Introduces you to the eco DC, its purpose, 
features, and functions.

Chapter 2, Installation, Provides the necessary steps to install eco DC.

Chapter 3, First-time Setup, Provides the basic operation instructions for 
first-time setup of eco DC.

Chapter 4, Energy, Guides you through how to monitor the energy used via 
ATEN PDUs.

Chapter 5, User, Guides you through how to manage the two different types 
of user login accounts: administrator and user.

Chapter 6, Device, Covers how to configure the devices, eco PDUs, 
managed.

Chapter 7, System, Guides you through other system settings of eco DC.

Chapter 8, Log, Describes the system and device logs recorded by eco DC.

Appendix, Provides certificate information and utility details regarding the 
eco DC.

Note:

Read this manual thoroughly and follow the installation and operation 
procedures carefully to prevent any damage to the unit or connected 
devices. 
ATEN regularly updates its product documentation for new features and 
fixes. For an up-to-date eco DC documentation, visit 
http://www.aten.com/global/en/

Models Product Names

eco DC Energy & DCIM Management Web GUI

http://www.aten.com/global/en/
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Conventions
This manual uses the following conventions:

Monospaced Indicates text that you should key in.

[ ] Indicates keys you should press. For example, [Enter] means to 
press the Enter key. If keys need to be chorded, they appear 
together in the same bracket with a plus sign between them: 
[Ctrl+Alt].

1. Numbered lists represent procedures with sequential steps.

♦ Bullet lists provide information, but do not involve sequential steps.

> Indicates consecutive selecting options (such as on a menu or 
dialog box). For example, Start > Run means to open the Start 
menu, and then select Run.

Indicates critical information.
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Chapter 1
Introduction

Overview

The ATEN eco DC Web GUI has been developed to work with ATEN PE 
series green energy power distribution units (PDUs) to effectively increase the 
efficiency of data centers’ power usage. Eco DC is a web-based GUI allowing 
users to manage and control PDUs through a web browser. There is no 
additional software to install or setup steps needed to manage your ATEN 
PDUs. The eco DC can run in any OS platform allowing users to easily manage 
the power consumption of a data center through intuitive interface with easy to 
read graphics.

Coupled with sensor-enabled eco PDUs*, the eco DC web GUI can give you 
means to assess, diagnose, and estimate how much energy you are using and 
ultimately save. Following the suggestions generated by the sensor-enabled 
system allows you to optimize energy usage to save energy without harming 
your IT equipment’s reliability. The ATEN eco DC web GUI provides secure 
and centralized (single portal, single login) access, administration, and 
management for up to 3000 PE devices over the network – local and worldwide 
– anywhere and anytime.

Because ATEN eco DC offers a single, integrated web-based GUI to manage 
all your devices, users no longer need to learn the interface for each individual 
device or remember every device’s IP address, making system management 
easier and more efficient.
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By consolidating the management of your ATEN devices, eco DC allows every 
device to be accessed and controlled by means of a single login. Its ability to 
manage all outlets in different ATEN devices makes eco DC the ideal solution 
for the power management of large data centers and branch office server rooms 
located in several remote locations within the same intranet.

ATEN eco DC is able to automatically discover all ATEN devices within the 
same intranet and has the ability to monitor/manage them. The web GUI 
provides monitoring/managing of PE device outlet power ON/OFF/Reboot, 
sequential ON/OFF of outlet, current / kWH / environmental monitoring at 
PDU/outlet level, name of outlet, current / kWH / environmental sensor 
threshold setting/alert, etc., through SNMP. Threshold exceeding alerts are 
also available through Syslog/SMTP.

* See Compatible Products on eco DC’s web page for a list of compatible 
ATEN sensor-enabled eco PDUs.

ATEN’s eco DC offers the full functionality capable of managing the PDUs 
through SNMP. This allows multiple users to log to the web GUI concurrently 
to manage PDUs in different authorized room, floors, or buildings, making 
distributed PDU management much more efficient under one centralized 
environment. With two levels of authorized user accounts and permissions, 
users can be configured to monitor and manage different functions of each 
PDU. Having this new web-based version allows data centers to optimize their 
performance and centralize their management.
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Features

Automatic discovery of all ATEN devices within an intranet
Remote real-time power measurement and monitoring

PDU level current / voltage / power dissipation / power consumption
Outlet On / Off / Recycle status
Circuit breaker status monitoring

Windows pop-out to easily monitor the data center’s status’
Remote real-time power outlet management*

Power outlet On / Off / Cycle switching by outlet or user-defined group
Power outlet On / Off / Cycle switching with pre-defined schedule
User-defined outlet level delays for sequential power up
Current / Voltage / Power Dissipation / Power Consumption threshold 
level setting
User access assignment for every outlet
Name assignment to individual outlets

Remote real-time environment sensor monitoring
Temperature / Temperature + Humidity reading
Temperature and Humidity threshold level setting

Plotting / Monitoring of all PE devices
Add data center server racks
Add PE devices for each server rack
Manage device / device outlet status for each plot

Essential indices including Rack Intake Temperature, Rack Exhaust 
Temperature, Rack Equipment, and Temperature Difference
Power analysis report for optimizing data center energy management – 
including power usage, power load, power cost, CO2 cost, power capacity 
and trends
Exceed threshold alert through SMTP and Syslog
3-phase PDU compatibility — 3-phase power distribution for managing 
data centers with heavy workloads
Cascade support — can monitor PDUs cascaded via Ethernet ports (1 x 1 
Gb + 1 x 100M)
Syslog provision
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Two-level password security
Strong security features include password protection and advanced 
encryption technologies – 128-bit SSL
Supports online UPS and SNMP Card
Real-time status charts for Current / Voltage / Wattage remote monitoring

Note: Not all functions are supported by all ATEN eco PDU PE models. 
Please see , page 6, and your eco PDU PE User Manual for further 
details.

Requirements

Systems that the eco DC web GUI will be installed on should meet the 
following requirements:

Server Version Client Version

Operating System Windows 7 / Windows Server 2008 or later

CPU 2.5 GHz Quad Core 2.0 GHz Dual Core

Resolution Larger than 1440 x 900

Memory 8 GB 4 GB

Disk 1 TB NA

Network 1 Gbps Ethernet
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Sensors

For complete energy management of an instrumented data center with the use 
of the ATEN eco PDU and eco DC web GUI, you should install 4 sensors for 
each of the racks in your data center in order to generate a complete energy-
efficient data chart. Higher sensor installation density is helpful to generate 
more accurate data. 8-port models have 2 sensor ports. In this case, Sensor 1 
needs to be installed at the intake of the rack (EA1140 or EA1240) and sensor 
2 needs to be placed at the exhaust of the IT equipment of the rack (EA1140 or 
EA1240) or the floor (EA1340).

To get the most complete eco DC web GUI data, the recommended 2 eco PDU 
unit per rack sensor setup is show in the table, below: 

eco PDU Port Location Part Number Sensor

eco PDU 1 Sensor 1 Intake EA1240 Temperature / 
Humidity

Sensor 2 Floor EA1340 Differential Pressure / 
Temperature

eco PDU 2 Sensor 1 Intake EA1240 Temperature / 
Humidity

Sensor 2 Exhaust EA1240 Temperature / 
Humidity
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Chapter 2
Installation

Before You Begin

The eco DC Web GUI can be downloaded from the ATEN website. The 
package requires a product key to complete the installation. Once you have 
downloaded and saved the installation file, follow the instructions below:

Installing eco DC

1. Double-click the eco DC setup file to open the installer. The Introduction 
window appears:

Click Next to continue.

2. The License Agreement window appears:

Check “I accept the terms of the license agreement” and then click Next to 
continue.
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3. The Serial Number window appears:

Enter your serial number and click Next to continue.

4. The Choose Installation Folder window appears:

Use the default directory or click Choose... to specify a location on your 
computer. Click Next to continue.

5. The Choose Folder Shortcut window appears:

Choose the locations you would like eco DC shortcut icons to be placed. 
Click Next to continue.
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6. The Configure & Setup window appears:

Key in the eco DC Server name, HTTP port, and HTTPS port, or use the 
default settings, and click Next to continue.

7. Two more windows will appear informing you that the configuration and 
server installation is OK. Click Next, and then Continue. 

8. The Pre-Installation Summary window appears, review the setup 
information and click Install to continue. 
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9. When the installation is finished, the Installation Complete window 
appears. Click Done to exit. 
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Post-installation Check
After the installation, the eco DC program starts automatically (and starts 
automatically with every bootup).

To check that the eco DC has started, go to the Services desktop app (shown in 
Desktop Service Check on page 12) and see if Running is shown under the 
Status column.

If Running is not shown, you can click Start to start the service.
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Desktop Service Check

Follow the steps below to go to the Service desktop application:

1. On your windows desktop, search for the keyword Services and click to 
start this desktop app.

2. Scroll down the list to find the eco DC service.
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Chapter 3
First-time Setup

Logging In

To log into the eco DC, do the following:

1. Open a web browser and type the following address:127.0.0.1

2. The eco DC login screen appears: 

1. Provide a valid Username and Password.

Note: If this is the first time you are logging in, use the default Username: 
administrator; and the default Password: password. For security 
purposes, the system will prompt you to change the password.

2. Use the drop-down menu to select your desired language. 

3. Click Login to bring up the main page.
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The Web Browser Main Page

Once you have successfully logged in, the eco DC user interface Main Page 
appears. Each of the interfaces is described in the sections that follow. The look 
of the page varies slightly, depending on which user account is used to log in. 

After users log in and are authenticated, the Web Browser Main Page comes 
up, with the Device - Dashboard page displayed:

Page components are discussed on the next page. 
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Page Components
The web page screen components are described in the table below:

No. Item Description
1 Toolbar The toolbar contains the eco DC main operation 

categories. The items that appear here are 
determined by the user’s type, and the authorization 
options that were selected when the user’s account 
was created.

2 Sub-toolbar The sub-toolbar contains operational sub-categories 
that pertain to the item selected in the toolbar. The 
items that appear in the sub-toolbar are determined 
by the user’s type, and the authorization options that 
were selected when the user’s account was created.

3 Menu The menu section is another sub-category of the 
sub-toolbar. It determines which tabs are available.

4 Tabs Various tabs are available that can be selected for 
interactive information/details.

5 About About provides information regarding the switch’s 
current firmware version.

6 Settings Click these buttons to select options relevant to the 
current session. 

7 Interactive Display Panel This is your main work area. The screens that appear 
reflect your toolbar, sub-toolbar, menu and tab 
choices. 
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Toolbar
The number and type of icons that appear on the toolbar at the top of the page 
are determined by the user’s type (Administrator or User) and the permissions 
assigned when the user’s account was created. The functions associated with 
each of the icons are explained in the table below:

Icon Function
Energy: This page is used to view and capture information about your 
PDU and data center’s energy use. This page is available to all users.

User: This page is used to create and manage Users and Groups. It 
can also be used to assign devices to them. This tab is available to 
Administrators who have been given User Management permission. 
The tab doesn’t appear for other users.
Device: The Device Management page is used to add devices and 
configure the overall operation of the data center. This page is only 
available to Administrators who have been given Device Management 
permission. The tab doesn’t appear for other and users.
System: This page is used to manage various system options which 
help manage the overall operation of the eco DC web GUI. This page 
is available to Administrators who have been given System 
Management permission. The tab doesn’t appear for other and users.
Logs: This page is used to view contents of the log file. This page is 
available to Administrators who have been given Log permission. The 
tab doesn’t appear for other and users.
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Settings
The Settings icons appear for all users. There are three icons that appear on the 
right end of the sub-toolbar. The functions associated with each of the icons are 
explained in the table below:

Icon Function
Preference: This icon opens a window allowing you to set personal 
settings for the current user.

Idle Timeout: Sets the amount of time that can pass before the user 
is automatically logged out of the web session. 

Max Notifications: Sets the maximum number of notifications that 
can appear when the Notification icon is clicked. You can set which 
notifications are shown here (see Events, page 112).

Preferred Page For Energy Tab: Use the drop-down menu to select 
the default sub-toolbar to be displayed for the Energy Toolbar.

Password: Use these settings to create a new password by 
checking Reset password and then key in the old password, new 
password, and confirm password. 

Discard: Click to exit without saving changes. 

Save: Click to save changes. 

Notifications: This icon is used to view and delete notifications that 
have been setup. Clicking the icon reveals options to view, delete, 
mark as read and clear all notifications. To select which notifications 
are received, see Events, page 112.
Exit: Click this icon to log out of the eco DC web session. 
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Quick Step-by-Step Setup

Once you have logged in, you need to define your data center and configure 
various parameters before you can begin to use ATEN eco DC to monitor and 
manage your devices. You will need to: add PDUs and configure their 
threshold settings; setup the layout; add racks, and then add PDUs to the racks. 

The steps below provide a quick reference to the sections of the user manual 
you can refer to in order to do this successfully. 

1. Go to Device - Installation, and under the Device tab add ATEN PDUs 
(see Adding Devices, page 78). 

2. Go to Device - Installation, and under the Device tab select PDUs in the 
sidebar and configure the Threshold Settings for each device (see Devices, 
page 79).

3. Go to Device - Installation, and under the Layout tab setup the data center 
by adding a: Data Center, Building, Floor, and then Room (see Layout, 
page 86).

4. Go to Device - Installation, and under the Layout tab, select a room and 
add racks to it, and then add the PDUs to the racks (see Adding Racks, 
page 88).

5. Once you have completed these steps, please proceed to Energy, page 19.
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Chapter 4
Energy

Overview

The Energy toolbar provides four sub-toolbar options: Dashboard to view real-
time power measurements and environment monitoring; Power Control to 
manage the power of PDUs and outlets; Analysis to generate energy usage 
reports; and Schedule to create group control tasks. 
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Dashboard

The Dashboard features Widgets and Charts in the Menu. They show the 
overall energy and environmental information collected about your data center. 
The Tabs of the interactive display panel lists different tabs depending on your 
Menu selection. The Widgets menu lists five categories for viewing related 
data in the main panel: Device, Power, Thermal, Pressure, and Humidity. The 
Charts menu lists Current, VA, and Wattage. Each tab can be selected to 
display different types of information about your data center. 

In the top right corner are three icons: Lock/Unlock to lock/unlock the position 
of all widgets on the page; Widget Settings (shown below) allow you to add/
remove widgets and lock their position on the page; and Maximize Window 
to pop open a new window to display the current data. 

Check the widgets listed in Widget Settings to add/remove them from the 
Dashboard page and click Apply to save. 
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Widgets

Widgets on the Dashboard display information about different parts of your 
data center energy and environmental usage. You can position widgets 
anywhere on by page by drag-and-drop, after the window has been unlocked 
using the Lock icon in the top right corner.You can remove widgets from the 
page by clicking the X in the top right corner of its window. 

Clicking the Diagnosis button opens a new window with detailed information 
about the data, as discussed in the sections that follow. The pages the follow 
discuss each of the widgets that can be added to Dashboard for monitoring. In 
the Diagnosis window use the left sidebar to select a room to view its data. 

Quick View Color Scale
The Diagnosis sections of Widgets use the same color scale, but with different 
units for each reading. For example, the Power Consumption page, under the 
Power, displays a scale from 0.7 – 4.3 kWh, as shown below:

Selecting a color in the scale highlights the racks with that particular reading. 

Check Select All to view each rack in a color according to its reading. The 
racks are displayed in a color related to their status on the various scales. 
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Device

Available Power Capacity

Displays the Average % of available power for all the racks. The Available 
Power Capacity uses a standard formula for rack devices: 

Total Power Capacity (KWh) - Power in Use (KWh) = Available Power 
Capacity (KWh).

Click Diagnosis to open a window with options to view additional rack data:
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You can click each rack to display the percentage of available power for that 
rack. The colors represent the available power capacity for each rack displayed 
in 5% increments. Uncheck Select All and click a color to view the racks which 
are recording data within that 5% range. Use to jump to a device’s Power 
Control page. 

Current

Displays the real-time measurement of the two devices with the minimum and 
maximum Current, and the average Current measurement of all devices.
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Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Current reading for that rack. The colors 
represent the average, maximum, and minimum Current readings. Use to 
jump to a device’s Power Control page. 
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Door Status

Door Open displays the open/close status of each cabinet door installed with a 
door sensor (EA1440, EA1441, or EA1442). GREEN: Rack Door is Closed. 
GRAY: No Door Sensor Installed. ORANGE: Rack Door is Open. 

Click Diagnosis to open a window with options to view additional rack data:

You can click the Open, N/A, or Close radio buttons to display the racks with 
that reading. The colors represent the data shown readings above. After 
selecting a rack, use  to jump to a device’s Power Control page. 
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Power Usage Efficiency 

The PUE is the ratio of the total energy used by the data center to the energy 
delivered to connected equipment. PUE is the inverse of data center 
infrastructure efficiency (DCIE).

PUE Reading DCIE Level of Efficiency

3.0 or higher 33% Very Inefficient

2.5 40% Inefficient

2.0 50% Average

1.5 67% Efficient

1.2 83% Very Efficient
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Rack Power Threshold

This displays the power threshold levels of each rack in four categories: 
Critical, Warning, Missing, and Normal. 

Click Diagnosis to open a window with options to view additional rack data:

You can click each device in a rack to display all reading for that device. The 
colors represent the number of racks at different readings, as shown above. Use 
the radio buttons to highlight racks at each reading. After clicking a rack, use 

 to jump to a device’s Power Control page. 
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Voltage

Displays the real-time measurement of the two devices with the minimum and 
maximum Voltage, and the average Voltage measurement of all devices.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Voltage reading for that rack. The colors 
represent the average, maximum, and minimum Voltage readings. Use to 
jump to a device’s Power Control page. 
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Power

Power Consumption

Displays the real-time measurement of the two devices with the minimum and 
maximum Power Consumption, and the average Power Consumption 
measurement of all devices.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Power reading for that rack. The colors 
represent Power readings ranges. Select a tab to view Power Consumption by 
a particular time range. Use to jump to a device’s Power Control page. 
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Heat Load Density

Displays the real-time measurement of the two racks with the minimum and 
maximum Heat Load Density, and the average Heat Load Density 
measurement of all racks.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Heat Load Density reading for that rack. 
The colors represent Heat Load Density ranges. Use to jump to a device’s 
Power Control page. 



 Chapter 4. Energy

31

Thermal

Inlet-Outlet Temperature Rise

This page displays the real-time inlet-outlet temperature rise values, at the 
minimum, maximum and the average reading. The color scale displays a range 
from 2–20 °C.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Inlet-Outlet Temperature Rise reading 
for that rack. The colors represent Inlet-Outlet Temperature Rise ranges. Use 

to jump to a device’s Power Control page. 
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Rack Inlet Temperature

This page displays the real-time rack inlet temperature values, at the minimum, 
maximum and average reading.The color scale displays a range from 10–45°C.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Rack Inlet Temperature reading for that 
rack. The colors represent Rack Inlet Temperature ranges. Use to jump to 
a device’s Power Control page. 
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Rack Outlet Temperature

This page displays the real-time rack outlet temperature values, at the 
minimum, maximum, and average reading.The color scale displays a range 
from 10–45°C.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Rack Outlet Temperature reading for 
that rack. The colors represent Rack Outlet Temperature ranges. Use to 
jump to a device’s Power Control page. 



eco DC User Manual

34

Thermal Status

This page displays the real-time thermal status values, at the minimum, 
maximum, and average reading.The color scale displays a range from 10–
45°C.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Thermal reading for that rack. The colors 
represent the average, maximum, and minimum Thermal readings. Use to 
jump to a device’s Power Control page. 
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Pressure

Inlet Differential Pressure

This page displays the real-time inlet differential pressure values, at the 
minimum, maximum, and average readings. The color scale displays a range 
from 0–200 Pa.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Inlet Differential Pressure reading for 
that rack. The colors represent the average, maximum, and minimum Inlet 
Differential Pressure readings. Use to jump to a device’s Power Control 
page. 
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Pressure Status

This page displays the real-time pressure values, at the minimum, maximum, 
and average reading. The color scale displays a range from 0–200 Pa.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Pressure Status reading for that rack. 
The colors represent the average, maximum, and minimum Pressure Status 
readings. Use to jump to a device’s Power Control page. 
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Humidity

Cold Inlet Dew Point Temperature

This page displays the real-time cold inlet dew point temperature values, at the 
minimum, maximum, and average reading. The color scale displays a range 
from 0–15 °C.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Cold Inlet Dew Point Temperature 
reading for that rack. The colors represent Cold Inlet Dew Point Temperature 
ranges. Use to jump to a device’s Power Control page. 
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Cold Inlet Relative Humidity

This page displays the real-time cold inlet relative humidity values, at the 
minimum, maximum, and average reading. The color scale displays a range 
from 10–90%.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Cold Inlet Relative Humidity reading for 
that rack. The colors represent Cold Inlet Relative Humidity ranges. Use to 
jump to a device’s Power Control page. 
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Humidity Status

This page displays the real-time humidity values, at the minimum, maximum, 
and average reading. The color scale displays a range from 0–90%.

Click Diagnosis to open a window with options to view additional rack data:

You can click each rack to display the Humidity Status reading for that rack. 
The colors represent the average, maximum, and minimum Humidity Status 
readings. Use to jump to a device’s Power Control page. 
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All Widgets
The All Widgets page displays widgets from every category listed in the tabs. 
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Charts

The Charts menu lets you put data group information against time into a chart. 
The data group information available are Current, VA, Wattage, Temperature, 
and Humidity. Use the tabs to choose which particular information chart(s) are 
displayed.

You can place up to 4 data group’s information into a single chart for 
comparison, and create up to 32 charts. An example is shown:

4 data group’s current information is shown in the top-most chart while only 1 
data group’s is shown in the bottom-most chart.

The button “Real-time” is a drop-down menu button. Click the menu for a list 
of available time periods the information is to be displayed, and click to select 
your option:
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When you move your mouse over a chart, the chart’s border becomes blue and 
extra options become available (top right corner). An example is shown:

Export 
When you click the Export icon, a pop-up window appears. An example is 
shown:
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To get a report, 

1. Enter a name for the Author field.

2. Click the End time field to select the date and time the data collection 
ends.

3. Click to check/uncheck the Report types (multiple selection available).

4. Click to check/uncheck the Groups involved.

5. Click Apply.

The report will be a pdf file. Choose a way you wish to open the file. An 
example of the report is shown:
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Settings 
When you click the Settings icon, a pop-up window appears for you to modify 
the chart’s settings. An example is shown:

After your modifications, click Apply to save the changes.

Delete 
If you wish to delete the chart, click the Delete icon. A system confirmation 
message will pop-up as shown:
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Lock / Unlock 
When you click this icon, you can toggle this chart between locked and 
unlocked. When unlocked, you can drag the chart around to re-arrange its 
position. The chart at the chart position you wish to drag to must also be 
unlocked. An example of moving a chart is shown:

If you wish to unlock/lock all the charts, click the lock icon  on the top right 
corner of the interactive panel.

Hide 
If you wish to hide the chart from displaying, click this icon.

To unhide the hidden charts, click the Chart Selection icon  on the top right 
corner of the interactive panel for a list of charts. An example is shown:

Check the chart you wish to unhide and click Apply to bring it back.
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Maximize Window 
Click this icon to expand the current interactive panel to view the charts.

Interactions are exactly the same except the page is bigger and that there’s a 
Full Screen icon  to expand the interactive panel into full screen.
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Power Control

The Power Control sub-toolbar selection allows you to perform manual power 
management at the device or outlet level and displays detailed energy and 
environmental information about your data center. 

Note: Not all eco PDU PE models support outlet level power management. 
Please see , page 6, and your User Manual for further details.

Click on a device in the side bar and its page appears with the Voltage, Current, 
Power, Power Dissipation information displayed at the PDU, Bank and Outlet 
level:

The top bar on the page displays the PDU name, IP address, online status, and 
the ON, OFF and Reboot options to manually power manage the device.

Sensors
This section is view only and provides status information about the sensors.

Banks
Use the ON, OFF and Reboot options to manually power manage the banks.

Outlet Status
Use the ON, OFF and Reboot options to manually power manage the 
individual outlet.
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Group Control
The Group tab allows you to perform simultaneous manual power 
management at the outlet level on data groups that you have already created. 

Note: 1. See Data Group, page 91, for details about creating groups for power 
management control.

2. Not all models support outlet level power management. Please see , 
page 6, and your User Manual for further details.

Click on a group in the side bar and its page appears, as below:

The sidebar provides predefined groups that can be selected to manage outlets 
that are grouped together. Use ON, OFF and Reboot on the top bar to reboot 
outlet groups; or use the same power options listed next to the outlets in the 
main panel to manage the power of individual outlets. 
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Analysis

The Analysis page allows you to create Power, Thermal and Billing reports to 
better understand energy use, environmental factors and costs associated with 
your data center. 

Generate
The Generate tab allows you to establish the parameters and schedule for the 
reports that you want to create. Select a report type in the sidebar and then click 
Add Task to begin configuring the report. 

The Generate Report fields are explained in detail in the following table:

Field Explanation

Menu The menu provides three options to generate reports:

Power – to create reports based on power usage.

Thermal – to create reports based on temperature. 

Billing – to create reports based on costs. 

Add Task Clicking Add Task opens a window that provides options to generate 
custom reports about your data center’s energy and environmental 
usage. 

Modify Check boxes in the main panel to select tasks then click Modify to 
make changes to them. 

Delete Check boxes in the main panel to select tasks then click Delete to 
remove it from the list.

Stop Click Stop if you want to stop a task thats in the process of being 
generated. 
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Power / Thermal

After you click Add Task a window opens to configure the report parameters:

The Power and Thermal fields are explained in the following table:

Generate 
Now

Select a task in the main panel by checking its box and then click 
Generate now to create the report. Once completed, the report will 
appear in the Completed Reports tab. 

Field Explanation

Report Type Use the radio buttons to select a report type:

Data Group Report– to create a report based on groups of devices.

Room – to create a report based on all devices in a room.

Information Use the Title and Author fields to enter information about the custom 
report. Use the Type drop-down menu to select how often to generate 
a report: Once, Daily, Weekly, Monthly, or Yearly. 

Report 
Duration

Allows you to generate the report based on a time frame. 
Enter the Start / Generate (when you want the report to begin/end), the 
Period (options are hour, day, week, month, or quarter) and the 
Duration (1–24), then use the Keep Report For drop-down menu to 
select the amount of time to pass before the report is deleted. Select 
Permanent to keep the report indefinitely. 

Field Explanation
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Billing

After you click Add Task a window opens to configure the Billing parameters:

The Billing fields are explained in the following table:

Add Click Add to add up to four device groups or rooms for which the report 
will be generated about.

Unit When Data Group (Power reports only) is selected you need to 
configure these three parameters to generate customized reports 
related to your data center’s energy costs. 

Select Charts 
/ Tables

Use the check boxes to select the type(s) of information you want to 
collect for the report. The more options that are selected the longer the 
report will take to generate. 

Generate After entering the parameters, click Generate to add the report to the 
list. 

Field Explanation

Add Click Add to add up to four device groups for which the billing report 
will be generated about. 

Information Use the Title and Author fields to enter information about the custom 
report. Use the Type drop-down menu to select how often to generate 
a report: Once, or Monthly. 

Field Explanation
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Report 
Duration

Select the month to run the report and the time to generate the report. 
Use the Keep Report For drop-down menu to select the amount of time 
to pass before the report is deleted. Select Permanent to keep the 
report indefinitely. 

Billing Rates Use the radio button to select the type of rate:

Single Rate – to create a report based on a single dollar figure. Use 
the Billing Type drop-down menu to select:

Total: a report based on all rack devices.

Rack: a report based per rack with a subtotals.

Dual-Rate – to create a report based on two different figures: Peak 
and Non-peak rates. Enter the time Peak rates start and the number 
of hours that the peak rate runs. Use the Billing Type drop-down 
menu to select:

Total: a report based on all rack devices.

Rack: a report based per rack with a subtotals.

Generate After entering the parameters, click Generate to add the report to the 
list. 

Field Explanation
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Reports
The Reports tab allows you to view or save reports that you’ve created.

Select a report type in the sidebar, check the box of the report(s) you want to 
view or save, and click Open or Save as to respectively begin viewing the 
report in a new window (the browser’s pop-up blocker must be disabled) or 
export the report as a PDF or Excel file. 
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Schedule

The Schedule page allows you to power on and/or power off outlets at regular 
intervals or on a specified time. 

Overview
A schedule page contains a schedules list and a main panel.

Schedules list: shows a list of created schedules.
Main panel: 

List view: click  to show a list of created schedules with 
information such as the target group (of outlets), execution status, and 
the interval type.
Configuration view: click a schedule from the sidebar to show the 
schedule settings.

Main PanelSchedules List
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Adding a Power-on / Power-off Schedule
1. In the eco DC main page, go to Energy > Schedule. 

2. In the sidebar, click . This window appears.

3. Configure the following settings.
Name: Name the task.
Type: Click the drop-down menu to select an interval type. 

Once: powers on or off the target outlet(s) on a specified date and 
time.
Daily: powers on and off the target outlet(s) daily at specified 
times.
Weekly: powers on and off the target outlet(s) weekly at specified 
times and days of the week.
Yearly: powers on and off the target outlet(s) at specified times and 
days of the week, with exceptions on specified dates.

Target Group: Click Browse to select a target group for the task. To 
add a data group, go to Device > Data Group.
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Scheduling: 
Once: Click to select On Time or Off Time, and then click on the 
date to specify the date and time in a pop-up calendar. Click Apply 
to save the setting.

Daily: Click to select On Time and then click on the time to set the 
on-time in a pop-up menu. Click Apply to save the setting. Repeat 
these steps to configure the off-time.
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Weekly: Click to select one or more On Time and then click on the 
time(s) to set the on time(s) in a pop-up menu. Click Apply to save 
the setting. Repeat these steps to configure their off-time(s).

Yearly: 
In the Regular tab, click to select one or more On Time and then 
click on the time(s) to set the on time(s) in a pop-up menu. Click 
Apply to save the setting. Repeat these steps to configure their off-
time(s).
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In the Exception tab, add the dates and times when the schedule 
needs to change.

4. Click Save. 

Editing a Power-on / Power-off Schedule
1. In the eco DC main page, go to Energy > Schedule. 

2. In the sidebar, click a schedule. The settings page appears.
For example:

3. Configure the settings as required.

4. Click Apply to save the configuration.
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Deleting Schedules
Use one of the following ways to delete schedules.

From the schedule page, click  to switch to list view, click to select 
one or more schedules, and click Delete on the top right.

From the sidebar, click a schedule, and then click .
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Chapter 5
User

Overview

When you select User from the toolbar the Accounts screen appears. eco DC 
supports two types of user accounts: Administrator and User. There are four 
sub-toolbar selections available from the User’s tab: Accounts, Authentication 
Services, and Sessions. 
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Accounts
To add an account, do the following:

1. Click +. The Add New User Account page appears:

2. In the User Information section, key in a Login name and Password, and 
select the Authentication Server. This screen is the same as when the 
account is selected from the sidebar. 

3. In the Type section, select the user type. Options are: Administrator and 
User.

Note: Administrators have full access rights by default; users have, by 
default, no access rights apart from “View Only” where they only 
have access to the Energy toolbar. If they are assigned group 
permission, on the other hand, they can access almost everything 
(see Selecting an Account, page 63). 

4. In the Access Permissions section, set the permissions of Administrator 
accounts. To set the device-by-device permissions for an account, open the 
user’s page from the sidebar and select the Device Access tab.

5. Click Save to save your settings.
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Selecting an Account

The Basic, Group Membership and Device Access tabs appears when you 
select a user account from the Menu. Use these tabs to edit this account’s 
permission to view and manage devices and groups. The Device Access tab do 
not appear for Administrator accounts as they have full permissions. 

Basic

This tab lets you configure the user information, type and permission. An 
example is shown below:

Click Apply if you wish to apply the changes you’ve made.

Group Membership

This tab displays the group(s) the user account belongs to. An example is 
shown:
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If you wish to add this user to a particular group, click Add on the top right 
corner. A list of available groups will be displayed in the dialog box as shown 
in the example below:

Check the box(es) you wish to add the user account to and click Add.

If you wish to delete the user from the group, check the box on the Group 
Membership tab and click Delete.
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Device Access

This tab displays the device(s) the user account has access to. An example is 
shown:

To add device access for the account individually, do the following:

1. Click Add on the top right corner. The Add Device Access Rights dialog 
window appears:

2. In the All column, check the boxes of the devices you want to allow the 
user to access. When the user logs in, these devices will appear in the 
sidebar. 



eco DC User Manual

66

Note:
If a user is given more access rights via Group Membership, the 
accessible devices will appear in Energy > Power Control > Device 
tab.
Administrators have full access rights by default; users have no device 
or group access rights by default. User accounts only have access to the 
Energy tab with view status and power control options. 

3. Click Add. When you are finished, click X. 

4. After adding devices they appear listed on the Device Access tab.
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Groups
This page displays the user groups you have previously created.

In the menu, you can also choose the “Domain Group” tab to show the groups 
according to the domain.

Add User Group

To add a user group, click the + icon above the menu:

Enter the appropriate information and click Save.
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User Group

2 tabs will be shown (Groups and Group Members) in the interactive display 
panel after clicking a user group in the menu.

Basic

You can configure the group’s information, type and permissions in this tab. 
An example is shown:

Click Apply if you wish to apply the changes you’ve made.

Group Members

This tab displays all the group members of this group. An example is shown:

To delete the user from the group, check the box on the Group Members page 
and click Delete.
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If you wish to add group members, click Add for the dialog window shown 
below:

Check the box of the users you wish to add and click Add.

Domain Group

The page below is an example of the Domain Group:

To delete a domain group, check the group’s box and click Delete.
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Add Domain Group

To add a domain group, click the + icon for the dialog window below:

Select the Authentication Server, check/uncheck the group’s type and 
permissions and click Select User.

Select the user you wish to add by checking the box and click Apply.



 Chapter 5. User

71

Authentication Services
Clicking the Authentication Services sub-toolbar brings you to the information 
list. An example is shown:

Clicking one of the servers in the menu allows you to configure the external 
authentication server’s information or the password policy of the eco DC. By 
default, the eco DC authentication service appears in the menu and cannot be 
deleted.

Click eco DC in the menu and the Password Policy page appears:

Minimum username length 
(1-64)

Enter the minimum number of characters required for 
usernames. 

Minimum password length 
(1-32)

Enter the minimum number of alpha/numeric characters 
required for passwords. 

Password expires after
(1-999)

Enter the number of days that can pass before users are 
forced to create a new password. 
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External Authentication

Click any of the external authentication servers in the menu and the 
configuration page for the server will be shown in the interactive display panel. 
The page corresponds to the page shown in the Add Authentication Server page 
below.

To add an authentication server, do the following:

1. Click +. The Add New Authentication Server page appears:

2. In the Basic Information section, key in a Server name and Description, 
and select a Server Type:

Enforce password history 
(0-9)

Enter the number of unique passwords that must be 
used before an old password can be used again. 

Password must contain 
upper letters

Check this box to require users to have at least one 
uppercase letter in their password. 

Password must contain 
lower letters

Check this box to require users to have at least one 
lowercase letter in their password. 

Password must contain 
numbers

Check this box to require users to have at least one 
number in their password. 

Password must contain 
symbols

Check this box to require users to have at least one 
symbol (!, @, #, $, %, ^, &, *) in their password. 
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Active Directory 

Fill in the IP address, Port and Base DN.

Select Use SSL in Trust All Mode or Do not use SSL.

Select Browse with user credentials and enter the Username and 
Password; or User must input credentials when browsing. 

LDAP

Fill in the IP/Domain, Port and Base DN.

Select Use SSL in Trust All Mode or Do not use SSL.

Fill in the Key attribute, Object class, Full name attribute. 

Fill the User RDN.

Select Browse with user credentials and enter the Username and 
Password; or User must input credentials when browsing.



eco DC User Manual

74

RADIUS

Fill in the IP/Domain, and Port.

Select the Authentication type and fill in the Shared secret and 
Confirmed shared secret.

TACASC+

Fill in the IP/Domain, and Port.

Select the Authentication type and fill in the Shared secret and 
Confirmed shared secret.

3. Click Save to save your settings.
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Sessions
The Session page lets the administrator see at a glance which users are 
currently logged into the eco DC, and provides information about each of their 
sessions.

Note: 1. The Session page isn’t available for ordinary users.

2. The sort order of the information displayed can be changed by 
clicking the column headings.

The meanings of the headings at the top of the page are fairly straightforward. 
The Client IP heading refers to the IP address that the user has logged in from; 
the Login Time tells you when the user logged in, and the Idle heading lists how 
long the account has been inactive.

This page also gives the administrator the option of forcing a user logout by 
selecting the username and clicking End Session at the top right corner of the 
main panel.
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Chapter 6
Device

Overview

The Device tab allows you to configure each device and define your data center 
by Data Center, Building, Floor, Room, and Rack. You can also define detailed 
parameters, such as Device Threshold Settings, at the PDU and outlet level and 
eco Sensors settings. See the following sections for more detailed information.

Note: 1. At least one rack must be installed and defined for eco DC to work.

2. Not all functions (such as outlet level monitoring) are supported by all 
models. Please see , page 6, and your eco PDU User Manual for 
details
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Installation

The Installation sub-toolbar options allows you to view and configure devices 
and define the layout of your data center. This page opens to the Device tab in 
the menu which lists all the devices in your data center:

Adding Devices
To add devices, do the following:

1. On the sidebar, click +. The New Device page appears to configure 
parameters and search for devices on the network:

2. In the Search PDU Devices section, select the device type (ATEN PDU, 
ATEN UPS, etc.) from the drop-down menu, key in the Start IP (v4) and 
Search Number. 

3. Enter the information under Default SNMP Agent Settings and click Next. 

4. When a list of devices appears, check the device boxes and click Add.
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Devices
The Devices tab lists all the PDUs in your data center. You can select devices 
to configure the settings by selecting them in the sidebar, or by double-clicking 
the devices in the main panel. When a device is selected, its first tab appears:

Device

Device Info This section displays the Name, IP/Domain, Model and 
Rack information for configuration.

SNMP Agent Settings Configure the SNMP Agent settings here.

Threshold Set the device threshold settings (min.–max), using the 
parameters provided, for:

Aggregate Current

Voltage

Aggregate Power

Aggregate Power Dissipation

Note: For these settings to appear click the Advanced 
Settings radio button.

Sensor Location Type Select the sensors’ locations from the drop-down menus.

Door Sensor Type Select the door sensor type from the drop-down menu. 

Apply Click Apply to save the settings.
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Bank

Device Info This section displays the device Name, IP/Domain, Model and Rack 
information.

Threshold Enter the bank Name, and use the drop-down menu to configure 
multiple banks individually, or check Apply to all banks to configure all 
banks with the same settings. Set the outlet threshold settings (min.–
max), using the parameters provided, for:

Current

Voltage

Power

Power Dissipation

Note: Depending on your device, not all these options may be 
available.

Apply Click Apply to save the settings.
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Outlet

Shutdown Methods
The three available shutdown methods are explained in detail below:

Kill the Power – If this option is selected, the device waits for the amount 
time set in the Power Off Delay field, and then turns the Outlet's power 
Off. Turning the power off performs a cold (non-safe) shutdown.
Wake on LAN – This is a Safe Shutdown and Restart option. If this is 
selected, when an Outlet is turned Off, the device first sends a message to 
the computer telling it to prepare for a shutdown; it then waits for the 

Device Info This section displays the device Name, IP/Domain, Model and Rack 
information.

Threshold Use the Outlets drop-down menu to select the outlet to configure, or 
use Apply to all outlets to configure the same settings for all outlets. 
Set the outlet threshold settings (min.–max), using the parameters 
provided, for:

Aggregate Current

Voltage

Aggregate Power

Aggregate Power Dissipation

Select one of the three choices for the Shutdown Method from the 
drop-down menu – see Shutdown Methods, page 81, for details.

Set MAC address and Delay Time On/Off for the selected method.

Apply Click Apply to save the settings.
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amount time set in the Power Off Delay field to give the OS time to close 
down before the computer is powered down to standby mode.
Likewise, when the Outlet is turned On, the device waits for the amount 
time set in the Power On Delay field, then sends an Ethernet message to 
the computer connected to the Outlet telling the computer to turn itself On.

Note: For Safe Shutdown and Restart, the computer must be running 
Windows (Windows 98 or higher), and the Safe Shutdown program 
(available by download from our website), must be installed and 
running on the computer.

System after AC Back – This is a Safe Shutdown and Restart option. If 
this is selected, when an Outlet is turned Off, the Device first sends a 
message to the computer telling it to prepare for a shutdown; it then waits 
for the amount time set in the Power Off Delay field to give the OS time to 
close down before the computer is powered down.
When the Outlet is turned On, the device waits for the amount time set in 
the Power On Delay field, then sends power to the server. When the server 
receives the power, it turns itself on.

Note: For Safe Shutdown and Reboot, the computer must be running 
Windows (Windows 98 or higher), and the Safe Shutdown program 
(available by download from our website), must be installed and 
running on the computer.
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Sensor

Device Info This section displays the device Name, IP/Domain, Model and Rack 
information for configuration.

Threshold 
Settings

This section provides the threshold settings for Sensors 1-4. Check 
Apply to same Model to use the same settings for all sensors 
connected to the same PDU model as the one you are configuring. Set 
the sensor threshold settings (min.–max), using the parameters 
provided, for:

Temperature

Humidity

Pressure

Apply Click Apply to save the settings. 
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POP
Depending on the ATEN PDU model, this tab may or may not appear, and 
different options will be available. Please refer to the user manual of the ATEN 
PDU selected for instructions on the available options. 

Device Info This section displays the device Name, IP/Domain, Model and Rack 
information for configuration.

POP 
(Proactive 
Overload 
Protection) 
Settings

This section provides the settings to configure Proactive Overload 
Protection for outlets. Check the Enable POP modes to use these 
feature. See the user manual of the selected PDU for details of the 
POP features and how to configure the settings. 

Apply Click Apply to save the settings. 
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UPS

If you choose a UPS device, this tab will appear.

Battery

The battery tab allows you to do battery self-test for the UPS.

Device Info This section displays the device Name, IP, Model, Rack and UPS F/W 
version information.

SNMP Agent 
Settings

For fields that can be entered, enter a parameter between the specified 
range. For fields that have drop-down menu, select from the available 
options.

Apply Click Apply to save the settings.

Device Info This section displays the device Name, IP, Model, and Rack information.

Battery 
Self-test

Select the test type and click Start to start the test.
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Layout
The Layout tab is for configuring the layout of your data center. The sidebar 
provides a tree-view list of the data center and its building(s), floor(s), and 
room(s).

Each level of the layout provides energy and basic information about that level 
of the data center. This information includes the number of PDUs, the average 
voltage, average aggregate power, and the number of buildings, floors, rooms 
and racks. 
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Adding Layout

There is a hierarchy which must be followed when adding the layout, meaning 
you must add one before the other, in this order: Data Center - Building - 
Floor - Room. You can add multiple Data Centers with multiple buildings, 
floors and rooms. At the room level you can configure the racks which contain 
the PDUs. 

To add a layout, do the following:

1. On the menu, click +. The Create Data Center Layer window appears:

2. Use the drop-down menu to select the Type: Data Center. Key in the 
Name, Country, City and Address. Click Apply. 

3. In the menu, select the Data Center and click + again. Use the Type drop-
down menu and select Building. Key in the Name, Country, City and 
Address. Click Apply. 

4. In the menu, select the Building and click + again. Use the Type drop-
down menu and select Floor. Key in the Name, Country, City and 
Address. Click Apply. 

5. In the menu, select the Floor and click + again. Use the Type drop-down 
menu and select Room. Key in the Name, Country, City and Address. 
Click Apply. 

6. You can add additional buildings, floors and rooms at each level. Once the 
Rooms have been added, you can select them to add racks to your data 
center. 
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Adding Racks

To add racks to a room, do the following:

1. In the sidebar, select a Room. A grid appears:

2. Click Edit. A page appears to add racks to the room. Use the bar options to 
Select and Change, Zoom and Pan, Auto Fit, and set the Layout’s grid size. 

3. Right-click on a square and how the rack is to be positioned:
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4. Enter the number of racks to add, and click Apply. The racks appear in the 
position that you selected. You can drag-and-drop, delete, copy, and paste 
racks. Add racks until you’ve completed the design of your data center. 

5. To add devices, double-click a rack and click +.
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6. Select the device(s) and click Add.

7. After adding all the devices to each rack, click Exit.

8. On the Room page, click racks to view the list of devices. Racks without 
devices appear gray. 
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Data Group

The Data Group sub-toolbar option allows you to create groups of racks, 
devices or outlets for power management control. The menu and the main 
panel lists groups that have been created. The first three groups 
(BUILTIN_RACK, BUILTIN_DEVIC, BUILTIN_OUTLET) contain all 
units in their Group Unit and cannot be deleted. 

To define a group, do the following:

1. On the sidebar, click +.The Add Data Group page appears:

2. Key in the Group Name and select the Group Unit: Rack, Device, or 
Outlet. 

3. Click Save.
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4. The Group appears in the menu, and opens to the page where you can add 
Racks, Devices, or Outlets. 

5. Click Add. The Add Data Group Member page appears:

6. Use the tabs to find racks, devices, or outlets to add to the group. The tabs 
that appear depend on the Group Unit type that was selected. 

7. Click Apply. 
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Firmware Upgrade

The Firmware Upgrade sub-toolbar option allows you to add firmware 
upgrade files and then create tasks to apply the update to the appropriate 
devices. 

To add a firmware file and schedule an upgrade task, do the following:

1. On the main bar, click Add.The Add Firmware File page appears:

2. Key in the Description and click Choose File and browse to select the 
firmware upgrade file. 

3. Click Apply.

4. On the menu, select Upgrade Tasks.
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5. Click Add Task. The Firmware Upgrade Task page appears:

6. Key in the Task Name, select the Firmware File from the drop-down menu 
and click Scheduling to choose a date/time to run the task.

7. Select Check Firmware Version to have the upgrade check the devices 
firmware version before it installs. If the current firmware on the device is 
more up-to-date than the one being applied, the firmware will not be 
installed. 

8. Click Apply to save the scheduled firmware upgrade.

Run Upgrade Task Now
If you want to run a firmware upgrade straight away, check the task and click 
Run Now on the bottom right corner of the page. An example is shown below:
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Power Meter

The Power Meter sub-toolbar option lets you create Power Measurement 
Points. Power Measurement Points allow you to use Non IT Facility Energy 
data to compare to the data center’s IT Power data obtained from the ATEN 
PDUs. This information is used to calculate the PUE. You can obtain Non IT 
Facility Energy data from third-party power meters via URL: https://IP:Port/
PowerMeter.json?, or a simple power estimation.

To create a Power Measurement Point, do the following:

1. On the sidebar, click +. The Add Power Measurement Point page appears:

2. Key in the Name and Estimation (amount), select the Type, Power Type, 
and Unit. 

3. Click Save. 
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Tools

The Tools sub-toolbar options includes two menu functions: Search & 
Recovery and Bulk Configuration.

Search & Recovery
This tool searches the desired network and recover offline devices if possible. 
It will scan the specified IP address(es) to find matched device(s) that was 
offline and update its network settings (IP, port, SNMP parameters, etc.) to 
bring it online.

Bulk Configuration
If you wish to configure certain settings in a bulk, use this menu.
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To bulk configure:

1. Check the checkbox of the setting you wish to bulk configure and alter the 
setting (drop-down menu or enter information into the field).

2. Click Continue. The system will display a list of devices for bulk 
configuration.

3. Check the checkbox of the devices you wish to bulk configure and click 
Apply. The system will ask if you would like to continue.

4. Click Yes to complete bulk configuration.
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Chapter 7
System

Overview

The System tab allows you to set system, database and events settings for the 
eco DC software. 

General

This General sub-toolbar selection allows you to configure various system 
parameters:

Server
Allows you to view and configure basic eco DC server settings.

Provides the Server Information: Name, Current Time, and Timezone. 
Unexpected disconnect timeout shows how long the eco DC will wait 
when a user loses connectivity before ending the session. 
Configure the Server Settings: HTTP Port, HTTPS Port, Device Port.
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Device
Allows you to configure the default settings related to eco DC’s relationship 
with devices it connects to. 

Use the check boxes to:
Allow remote outlet control.
Enable alert for Neutral Leakage Current.
Synchronize device and outlet name.
Treat ATEN smart PDU as IT power. Checking this option means all 
the power from ATEN PDUs will be treated as IT Equipment Energy 
when calculating the data center's PUE. 

Set the Default SNMP Agent Settings: Port, Timeout, Retry (1~5), SNMP 
version, and Write Community. 
Use the Energy Box Voltage radio button to select a voltage:

Custom (90~260) – enter a custom voltage number.
Link to the device – click browse and select a energy box. 
Link to a random device – an energy box is selected for you.

Use the PDU Offline Detection to configure the function.
Check the Enable dedicated PDU offline detection to enable the 
function.
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Enter the detection period in the field (3~30)
Click Apply to save the settings.

SNMP trap
This section sets the SNMP trap server settings. 

SNMP Manager I – Check Enable to configure the first SNMP server:
Enter the IP address, Port SNMP version and key in the Community. 
Click Test to attempt a connection. 

SNMP Manager II – Check Enable to configure the second SNMP server:
Enter the IP address, Port SNMP version and key in the Community. 

Click Test to attempt a connection. 
Click Apply to save the settings.
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SMTP
Use these settings to have the eco DC email reports from an SMTP server.

SMTP

If required, check This server requires a secure connection (SSL) 
Check Enable to receive reports from the SMTP server. 

Enter the IP address, Port, and Send from (e-mail address).
If required, check This server requires authentication and key in the 
account name and password. 

Click Test to attempt a connection. 
Click Apply to save the settings.
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Email Notification

This tab allows you to setup email notifications.
Click Add for the email notification configuration window:

Enter the subject, recipients (multiple recipients option available) and 
language in the Information tab.
Check the checkbox of the notification events you wish the system to 
notify in the Event List tab.
Click Apply to add this notification to the system.

Check the checkbox of a current notification and click Modify to modify 
the configuration. Click Apply to save the configuration.
Check the checkbox of a current notification(s) and click Delete to delete.
Check the checkbox of any current notification and click Test (bottom 
right corner) to test if the system sends the notification.
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Syslog
Use these settings configure the Syslog server settings.

Syslog Server – Check Enable to use a Syslog server. 
Enter the Server, Port, and select the Protocol and Language.
When TCP protocol is selected (if needed), check This server requires 
authentication.

Click Test to attempt a connection. 
Click Apply to save the settings.

License
This page displays license information about the eco DC software.



 Chapter 7. System

105

Security
Use these settings configure the eco DC security settings.

Lock Out Policy – sets the user login policy. To use this feature, check 
Lockout users after invalid login attempts.

Key in the Maximum login failures (1~100) that users are allowed 
before their account is locked out. 
If you want to require the administrator to unlock a user’s account, 
select Require manual unlock. 
If you want a user’s account to unlock after a specific amount of time, 
select Unlock after (1~1000) and key the number of minutes. 

Single Sign On Settings – Check Enable single sign on if you wish to 
enable this function (allow users from another web application to log in 
eco DC automatically through a form-based authentication).

Key in the Username field identification string and Password field 
identification string for the single sign on account.
To integrate, please refer to SSO HTML on page 127.

Click Apply to save the settings.
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Certificate
This section provides information and allows you to update the certificates.

Certificate Information– provides information about the certificate: 
Subject, Issuer, Validity Period, Serial Number and SHA-1 thumb print.
Click Get CSR to save the certificate file (csr.cer) to a convenient location 
on your computer. This is the file that you give to the third party CA to 
apply for their signed SSL certificate.
Click Update to import a certificate.
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1. There are three types of certificates to select from: 
Create a new self-signed SSL server certificate:
Select the Key Length. 

Enter the Organization, City or Location, State and Country 
information. 

Import a signed SSL server certificate:
Certificate – click Choose File to upload the file.

Import Private Key and Certificate:
Private Key – click Choose File to upload the file.

Private Certificate – click Choose File to upload the file.

2. Click Apply. 
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Miscellaneous
This section configures default options for the eco DC interface. 

System Preferences – sets the default Temperature Unit and Currency. You 
can choose “User defined currency” from the Currency drop-down menu 
and enter the unit into the field the follows.
Default unit for report – sets the default 1kWh generate CO2, Electricity 
cost, and CO2 cost units to use for generating reports.
Default rate for billing – sets the default Single and Dual-Rate units for 
generating custom reports.
Data Group Option For Charts – check the checkbox under this option to 
keep historical data for charts.
Click Apply to save the settings.
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Health
This section provides System, Device and Database information. 

System – displays information about the local operating system, Java 
version, and eco DC version.
PDU Devices – displays the PDU sampling period, and information about 
devices the eco DC is currently managing. 
Database – displays statistics about the database the eco DC is managing, 
including the storing estimations, available storage, storage location, daily 
backup and disk space used. Details about the Database are provided in the 
next section.
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Database

This Database sub-toolbar selection allows you to configure settings related to 
the data stored by the eco DC. 

Access
The Access section, shown above, configures how the data is managed. 

Use the PDU sample rate drop-down menu to select how fast the eco DC 
collects data about devices.
Desired space consumption – use the drop-down menu to select, on 
average, how much disk space you want to utilize for data.
Use built-in database – select this option to save eco DC data on the local 
computer’s disk drive. By default, the eco DC will choose its own 
directory to save database files, or you can check User specified local 
folder to choose your own location to save the data. 
Use MySQL database – select this option to use an SQL database to save 
eco DC data. Check IP for remote database and key in the IP address, 
Port, Username and Password.
Click Apply to save the settings. 
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Maintenance
Use Maintenance to configure how the database is maintained. 

Database clean up option – enter the number of months you want the eco 
DC to save data before it begins deleting old data. Key a number between 
6 and 60. 
Database daily backup – to create a backup of that day’s eco DC data, 
check User specify local folder and key in the directory. If no location is 
entered the backup will be saved to the default directory: 
C:\ecoDC\data\EcoDC_dailyBackup 

Note: It is strongly recommended that you use the same directory for daily 
backup and the database backup (see Database Backup on page 122). If 
any of the data is backed up to a different location, you may lose this bit 
of data when restoring the database.
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Events

The Events sub-toolbar selection allows you to set which system messages to 
use and where to save them. 

In the main panel use the check boxes to select which Event type to save 
and where to send them, options are: 

Log – saves the events to the eco DC’s System Log which can be 
viewed on the Logs toolbar option. 
E-mail – sends the events that are checked to the e-mail address 
specified under SMTP settings (see SMTP, page 102). 
Notification – sends the events that are checked to the notification 
panel which can be found on the sub-toolbar by clicking the 
Notification icon (see Settings, page 17).
Syslog – sends the events to the Syslog server specified under System - 
General settings (see Syslog, page 104).
SNMP Trap – sends the events to the SNMP server specified under 
System - General settings (see SNMP trap, page 101).
Click Apply to save the settings. 
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Settings
Use the event Settings to configure how events are managed. 

Maintenance – key in the number of days you want the system to keep 
event logs for before they are deleted, Options are 7 to 1096 days. 
SNMP Trap Receiver – to use an SNMP Trap Receiver to receive device 
logs from PDUs, enter the required server information.
Click Apply to save the settings. 
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Chapter 8
Log

Overview

The eco DC keeps a record of transactions that take place on its installation. 
The System Log and Device Log pages provide an array of filters and functions 
that allow you to view and export the log file data. To set the number of days 
the event log stores, see Settings, page 113.

System Log
Clicking the System Log sub-toolbar button refreshes the log list with the 
latest events.
Recent Logs – key in search terms and click Search to find specific events. 
Items/Page – this drop-down menu at the lets you set the number of events 
to display per page. Choose between 25 to 400 events.
Page – depending on the items per page selected, this box allows you to 
key in a number and jump to that page. Click Go to jump to the page. 
First Page / Last Page – these two buttons on the bottom bar allow you to 
skip to the first and last log page. Between these buttons shows the page 
displayed and the total number of pages.



eco DC User Manual

116

Previous / Next – these two buttons on the bottom bar allow you to move 
backward and forward to view event log pages. Between these buttons 
shows the page displayed and the total number of pages.
Save – click to save a system_log.cvs files which contains a list of the logs 
currently being displayed in the main panel. Check Save all pages to save 
all of the events currently logged by the eco DC.

Device Log
The Device Log lists events sent from the devices added to the eco DC. The 
features and functions of the Device Log are essentially the same as the System 
log, as described above. See System Log, page 115 for details. 
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Technical Support

International
For online technical support – including troubleshooting, documentation, 
and software updates: http://eservice.aten.com
For telephone support, see Telephone Support, page ii.

North America

When you contact us, please have the following information ready beforehand:
Product model number, serial number, and date of purchase.
Your computer configuration, including operating system, revision level, 
expansion cards, and software.
Any error messages displayed at the time the error occurred.
The sequence of operations that led up to the error.
Any other information you feel may be of help.

Email Support support@aten-usa.com

Online 
Technical 
Support

Troubleshooting
Documentation
Software Updates

http://eservice.aten.com

Telephone Support 1-888-999-ATEN ext 4988
1-949-428-1111
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Trusted Certificates

Overview
When you try to log in to the device from your browser, a Security Alert 
message appears to inform you that the device’s certificate is not trusted, and 
asks if you want to proceed.

The certificate can be trusted, but the alert is triggered because the certificate’s 
name is not found on the Microsoft list of Trusted Authorities.

You can ignore the warning, click More information and click Yes to go on.

Note: To avoid users having to go through the certificate acceptance prompt 
each time they log in, you can use a third party certificate authority (CA) 
to obtain a signed certificate. Refer to Import a signed SSL server 
certificate:, page 107 under Certificate, page 106 for more details.
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ecoDC Utility

The ecoDC Utility gets installed as part of the eco DC installation procedure. 
It allows you to configure a number of the eco DC’s parameters from the 
desktop of the computer that the eco DC runs on, without having to invoke the 
browser GUI.

To run the program in Windows, click the Start menu, navigate to the ecoDC 
entry, and select ecoDC Utility:
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When you run the program, a screen similar to the one below appears:

The Utility offers four tabs: System Settings, Backup, Restore and View 
Licenses. Each of the tabs is described in the sections that follow.

System Settings
Apache Tomcat is the program that serves the eco DC’s web pages. The eco 
DC’s installation programs asks you to specify the ports that Apache Tomcat 
listens on for web requests.

The HTTP port is the regular port that Apache Tomcat listens on. The 
default is 80. If you use a different port, users must specify the port 
number in the URL of their browsers.
The HTTPS port is the secure port that Apache Tomcat listens on. The 
default is 443. If you use a different port, users must specify the port 
number in the URL of their browsers.

If a port conflict occurs with the ports that you have set and prevents the web 
page from opening, you can use this utility to change the port settings.

After making your settings, click Apply to save the changes.

If you wish to import private key or certificate, click Browse in the Import 
Certificate section, select the file and click Apply.

In the Administrator Management section, click Reset to return the 
administrator’s account to the default settings. Click Unlock if the account was 
previously locked.
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Backup
The Backup tab lets you backup current configuration or database.

Config Backup

Enter a config file name in the File name: field. Backed up file will be stored 
in the C:\ecoDC\Runable directory by default.

Alternatively, you can click Browse for a file dialog box, find a location you 
wish to store the backup file in, enter a name and click Open to return to the 
utility page.

Click Start to start the backup and the progress status will be shown in the 
progress bar.
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When completed, a success message will be shown:

Database Backup

Enter a database folder name in the Backup folder: field. Backed up folder will 
be stored in the C:\ecoDC\Runable directory by default.

Alternatively, you can click Browse for a file dialog box, find a location you 
wish to database backup and click Open.

Note: It is strongly recommended that you use the same directory for daily 
backup (see Maintenance on page 111) and the database backup. If any 
of the data is backed up to a different location, you may lose this bit of 
data when restoring the database.

Click Start to start the database backup and a warning will pop up.
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Click Yes and the progress status will be shown in the progress bar.

When completed, the utility will be closed and the eco DC service will restart.
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Restore
The Restore tab lets you restore configuration or database, or migrate a 
database to the eco DC service.

Click Browse (Config Restore, Database Restore, Database Migrate) and 
locate the file/folder you wish to restore/migrate and click Start.

Note: When restoring database, make sure your daily backup files (see 
Maintenance on page 111) and the database backup files (see Database 
Backup on page 122) are in the same folder as both backup file types 
contribute to a full database.

A warning will pop up as shown:
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Click Yes and the progress status will be shown in the progress bar.

When completed, the utility will be closed and the eco DC service will restart.

View License
The View Licenses tab lets you view the licenses that are related to the eco DC 
package. To view a license, click its radio button.
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Database Migration Tool

If you have eco Sensors installed previously, you can migrate data information 
from the eco Sensors to the eco DC using the Database Migration Tool.

To run the program in Windows, click the Start menu, navigate to the ecoDC 
entry, and select DbMigrate Tool:

The diagram below is an example of the migration tool.

To start the migration, click Start. When completed, a success message will be 
shown in the message box.
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SSO HTML

If Single Sign On is enabled, it will allow users from another web application 
to log in eco DC automatically through a form-based authentication. An 
example of the HTML sample codes is in the next section.

SSO HTML Sample Codes
<html>

<head><title>Sample page for eco DC SSO (Single Sign On) Sample</title></
head>

<script language="JavaScript">

<!--

function doLogin()

{

form1.submit();

}

-->

</script>

<body>

<table>

    <div align="center">

        <form id="form1" name="form1"  method="post" action="https://
10.3.166.65:443/ccadmin/singlesignon.do">

        <!-- Server_IP_port: eco DC server IP/port (default port could be omitted) 
-->

        <tr>

          <td>

        <font size=5>Test page for eco DC SSO (Single Sign On)</font> 
&nbsp;&nbsp;

          </td>

        </tr>
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        <tr>

          <td>

            eco DC Username: <input class="sw4" type="text" 
name="MySSO_Username" value="administrator" size="15"> <br><br>

            <!-- signonusername: Username field in eco DC SSO setting page -->

  </td>

</tr>

        <tr>

          <td>

            eco DC Password: <input class="sw4" type="password" 
name="MySSO_Password" value="password" size="15"> <br><br>

            <!-- signonpassword: Password field in eco DC SSO setting page -->

  </td>

</tr>

        <tr>

          <td>

          <!--

            eco DC Username: <input class="sw4" type="text" name="loginname" 
value="administrator" size="15">  &nbsp;&nbsp;&nbsp;&nbsp; eco DC 
Password: <input class="sw4" type="password" name="loginpass" 
value="password" size="15"> <br><br>

            -->

            <input class="bw" type="button" value="SSO to eco DC" name="login" 
onClick="doLogin();">

  </td>

</tr>

        </form>

    </div>

</body>

</html>
128



 Appendix
© Copyright 2022 ATEN® International Co., Ltd.
Released: 2022-06-29

ATEN and the ATEN logo are registered trademarks of ATEN International Co., Ltd. All rights reserved. 

All other brand names and trademarks are the registered property of their respective owners.
129


	PE Device Safety Notice
	User Information
	Online Registration
	Telephone Support
	User Notice

	Product Information
	About this Manual
	Conventions

	Introduction
	Overview
	Features
	Requirements
	Sensors

	Installation
	Before You Begin
	Installing eco DC
	Post-installation Check
	Desktop Service Check



	First-time Setup
	Logging In
	The Web Browser Main Page
	Page Components
	Toolbar
	Settings

	Quick Step-by-Step Setup

	Energy
	Overview
	Dashboard
	Widgets
	Quick View Color Scale
	Device
	Available Power Capacity
	Current
	Door Status
	Power Usage Efficiency
	Rack Power Threshold
	Voltage

	Power
	Power Consumption
	Heat Load Density

	Thermal
	Inlet-Outlet Temperature Rise
	Rack Inlet Temperature
	Rack Outlet Temperature
	Thermal Status

	Pressure
	Inlet Differential Pressure
	Pressure Status

	Humidity
	Cold Inlet Dew Point Temperature
	Cold Inlet Relative Humidity
	Humidity Status

	All Widgets

	Charts
	Export
	Settings
	Delete
	Lock / Unlock
	Hide
	Maximize Window

	Power Control
	Sensors
	Banks
	Outlet Status
	Group Control

	Analysis
	Generate
	Power / Thermal
	Billing

	Reports

	Schedule
	Overview
	Adding a Power-on / Power-off Schedule
	Editing a Power-on / Power-off Schedule
	Deleting Schedules


	User
	Overview
	Accounts
	Selecting an Account

	Groups
	Add User Group
	User Group
	Domain Group

	Authentication Services
	External Authentication

	Sessions


	Device
	Overview
	Installation
	Adding Devices
	Devices
	Device
	Bank
	Outlet
	Shutdown Methods
	Sensor
	POP
	UPS
	Battery

	Layout
	Adding Layout
	Adding Racks


	Data Group
	Firmware Upgrade
	Run Upgrade Task Now

	Power Meter
	Tools
	Search & Recovery
	Bulk Configuration


	System
	Overview
	General
	Server
	Device
	SNMP trap
	SMTP
	SMTP
	Email Notification

	Syslog
	License
	Security
	Certificate
	Miscellaneous
	Health

	Database
	Access
	Maintenance

	Events
	Settings


	Log
	Overview
	System Log
	Device Log


	Appendix
	Technical Support
	International
	North America

	Trusted Certificates
	Overview

	ecoDC Utility
	System Settings
	Backup
	Config Backup
	Database Backup

	Restore
	View License

	Database Migration Tool
	SSO HTML
	SSO HTML Sample Codes



